LaboTex
Version 3.0

The Texture Analysis Software for Windows

Menu and Toolbars Commands
## Contents

Contents ................................................................. 2

1. Menu and Toolbars Commands ........................................ 4
   1.1 File menu commands ............................................. 4
      1.1.1 New Sample/Project command (File menu) .................. 4
      1.1.2 Open sample command (File menu) .......................... 7
      1.1.3. Change/New User (File menu) .............................. 7
      1.1.4. ODF Export ................................................   8
      1.1.5. PF Export .................................................. 9
      1.1.6. EPF/PPF/COR/POW Export ................................ 10
      1.1.7. Print (File menu) .......................................... 10
      1.1.8. Print Setup (File menu) .................................... 10
      1.1.9. Crystal Symmetry (File menu) ............................. 10
      1.1.10. Recent Sample command (File menu) ...................... 10
      1.1.11. Exit command (File menu) .................................. 10

   1.2. Edit menu commands ............................................. 11
      1.2.1. Copy to Clipboard (EMF) ................................... 11
      1.2.2. Copy to Clipboard (Bitmap) ................................. 11
      1.2.3. Image File (BMP, TIF) ..................................... 11
      1.2.4. Clear Selected (Edit menu) ................................. 12
      1.2.5. Clear All (Edit menu) ....................................... 12
      1.2.6. The choice of the font ..................................... 12
      1.2.7. The choice of the color .................................... 12
      1.2.8. LaboTex Object Arrangement ............................... 13
      1.2.9. LaboTex Options ............................................ 14

   1.3 View menu commands .............................................. 21
      1.3.1. Single Window Mode (View menu) ........................... 21
      1.3.2. Compare Window Mode (View menu) ......................... 21
      1.3.3. 3-D View (Menu View) ..................................... 21
      1.3.4. Show InfoBox (View menu) .................................. 22
      1.3.5. Magnification (View menu) ................................ 24
      1.3.6. Basic Region (View menu) ................................ 24
      1.3.7. High Resolution ............................................ 25
      1.3.8. Number of Isolines ........................................ 25
      1.3.9. Fill .......................................................... 25
      1.3.10. User Defined Sections (PF, ODF) ......................... 36
      1.3.11. Grid (Pole Figure) ......................................... 44

   1.4. Calculation menu commands .................................... 46
      1.4.1. Experimental PF to CPF (Calculation menu) ............... 46
      1.4.2 Experimental Single Orientation Data to ODF (Calculation menu) 46
      1.4.3 CPF to ODF, RPF, NPF, INV (Creations of ODF, Calculation Menu) 46
      1.4.4. ODF to APF (Calculation menu) ............................ 48
      1.4.5. ODF to INV (Calculation menu) ............................ 49
      1.4.6. ODF to ODF, ODF Symmetrization (Calculation menu) .... 49
      1.4.7. ODF to SOR. (Calculation menu) ............................ 50

   1.5. Analysis menu commands ........................................ 52
      1.5.1. Orientation Analysis (Analysis menu) ...................... 52
      1.5.2. Show PF(s) or/and ODF(s) Value(s) (Analysis menu) ....... 52
      1.5.3. Choose (HKL)[UVW] (Analysis menu) ....................... 53
      1.5.4. Orientations Type Database (Analysis menu) ............... 54
      1.5.5. Sort of Orientations from Database by PF or ODF Values (Analysis menu) 54
1.5.6. Show of Next Orientation from Database (Analysis menu) ........................................ 56
1.5.7. Show of Previous Orientation from Database (Analysis menu) .................................. 56
1.5.8. Automatic Show of Orientations from Database (Analysis menu) ........................... 56
1.5.9. Near (HKL)[UVW] orientations (Analysis menu or right mouse button) ................. 56
1.5.10. Quantitative Analysis – Integration Method (Analysis menu) .................................. 57
1.5.11. Quantitative Analysis – Model Functions Method (Analysis menu) ....................... 58
1.6. ‘Modelling’ menu commands ....................................................................................... 60
   1.6.1. Model ODF (Modelling menu) ................................................................................. 60
   1.6.2. ODF Transformation (Modelling Menu) ................................................................. 61
   1.6.3. ODFs logical operations (Modelling menu) ............................................................ 64
1.7. Help menu commands .................................................................................................. 65
2. Object Toolbar .................................................................................................................. 66
1. Menu and Toolbars Commands

1.1 File menu commands

File menu offers the following commands:

- **New Sample/Project**: Creates a new sample for existing or a new project.
- **Open Sample**: Opens an existing sample.
- **Change/New User**: Changes current user or creates a new user.
- **ODF Export**: Export of ODF data as ASCII files.
- **PF Export**: Export of PF data as ASCII files.
- **EPF/PPF/COR/POW Export**: Export of original (or converted to LaboTex format) pole figures data.
- **Print**: Prints a 2D figure(s).
- **Print Setup**: Sets margins.
- **Crystal Symmetry**: Selects current crystal symmetry.
- **Recent Sample**: Opens recent sample.
- **Exit**: Exits LaboTex.

1.1.1 New Sample/Project command (File menu)

Use this command to create a new sample in LaboTex. Select the type of experimental files and file or files to process in the New Sample Dialog Box.

Specify the type of experimental data for processing – select proper radio button:
• EPF
• PPF
• SOR
- Other (user defined – non LaboTex format, for example: TSV, PLF, CON, HKL) (only 4 additional, non-LaboTex formats, may be simultaneously accessible)

2) Select file(s) (for many files select with CTRL key).
3) Select file for correction (if necessary):
   • COR
   • POW

4) Write new name for project or select an existing project.
   **Note:**
   • Do not use following symbols in project and sample name: W:?’<>|!
   • Up to 15 characters can be used in project and sample name.

5) Write name of sample or accept name prompted by LaboTex.
6) Start calculation and creation of objects:

- creation CPF objects from experimental pole figure: merge experimental files and conversion.

---

1 To make other formats accessible for creation of CPF files you should:
i) select EDIT menu in LaboTex
ii) select LaboTex Options
iii) select Data Formats
iv) select this format in one of "selection windows" 4 - 7
v) select "new sample" - selected format is now active.
creations ODF from single orientations data: merge experimental files and calculation ODF. Click "RUN" for start ODF calculation.

For example:
You would like read data in Rigaku 'ASC' data format files:
1) use only one pole figure in one file,
2) extension of file has to be ASC (for example: 53110.ASC, 53200.ASC, 53211.ASC)
3) to make ASC files accessible for creation of CPF files you should:
   i) select EDIT menu in LaboTex
   ii) select LaboTex Options
   iii) select Data Formats
   iv) select "ASC - Rigaku ASC format (1PF/file)" in one of "selection windows" 4 - 7 then
4) select "new sample" (from File menu or third icon from toolbar), select "ASC" data format, if you do not use defocusing correction, please select "off" for "Correction"
5) select ASC pole figures files by the mouse clicking
6) select the proper crystal symmetry for your sample

Shortcuts
Toolbar: 
Keys: CTRL+N
1.1.2 Open sample command (File menu)

Use this command to open an existing sample.

![Open sample dialog]

Shortcuts:

Toolbar:  ![Open sample icon]
Keys: alt+o

1.1.3 Change/New User (File menu)

Use this command to open a dialog to change current user or to create a new user.

When you create "New User", LaboTex makes new subdirectory in directory USER with user name and next LaboTex creates in this catalogue the all structure of user subdirectories. LaboTex copies also all sample files from main EPF and COR directory to user EPF and COR directory. Similarly LaboTex copies files from directory SETUP and DEMOFILE.

![New User dialog]
Note:
- Do not use following symbols in user name: \:?”<>|
- Up to 15 characters can be used in user name.

Shortcuts:
Toolbar: 
Keys: ALT+N

1.1.4. ODF Export
The option lets on the saving ODF data to the ASC file. The user can choose one from among three data formats:

a) \(\phi_1\) section - "ODF Export (Phi 1 Section)..." :
print to file \(\phi_1\) section of ODF. First value in first line is a \(\phi_1\) value. Next data in first line are values of \(\phi_2\) angle while first column contains values of \(\Phi\) angle:

```
<table>
<thead>
<tr>
<th>ODF projection PHI1</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHI1  PHI2 ---&gt;</td>
</tr>
<tr>
<td>PHI</td>
</tr>
<tr>
<td>V</td>
</tr>
</tbody>
</table>
```

For example (ODF section for \(\phi_1=0\)):

```
.0    .0    5.0  10.0  15.0  20.0  25.0  30.0  ...  60.0  65.0  70.0  75.0  80.0  85.0  90.0
.0   1.02  1.31  1.72  2.08  2.17  2.08  ...  2.05  2.10  1.98  1.61  1.23  .96  .86
5.0  1.00  1.68  1.81  2.30  2.53  2.40  2.01  ...  1.97  2.35  2.43  2.06  1.58  .97  .65
10.0 2.17  2.03  2.24  2.73  2.61  2.03  1.40  ...  1.20  1.32  1.33  1.14  .93  .65  .48
15.0 2.34  2.19  2.38  2.74  2.26  1.43  .81  ...  .49  .48  .41  .32  .27  .20  .16
20.0 2.06  2.32  2.27  2.18  1.46  .81  .42  ...  .18  .21  .22  .22  .21  .16  .12
...    ...    ...   ...   ...    ...    ...    ...  ...    ...   ...   ...   ...   ...   ...
70.0  2.24  2.24  2.36  2.15  1.47  .61  .42  ...  .19  .22  .23  .23  .21  .17  .14
75.0  1.95  2.06  2.50  2.64  2.09  1.32  .75  ...  .47  .47  .41  .31  .24  .20  .18
80.0  1.67  1.81  2.34  2.74  2.55  1.98  1.36  ...  1.20  1.37  1.41  1.15  .86  .69  .61
85.0  1.25  1.37  1.84  2.43  2.70  2.51  2.06  ...  1.97  2.38  2.42  1.97  1.48  1.07  .86
90.0  .88  .99  1.27  1.66  2.03  2.13  2.07  ...  2.07  2.13  2.03  1.66  1.27  .99  .88
```

b) \(\phi_2\) section - "ODF Export (Phi 2 Section)...":
Print to file \(\phi_2\) section of ODF. First value in first line is a \(\phi_2\) value. Next data in first line are values of \(\phi_1\) angle while first column contains values of \(\Phi\) angle:

```
<table>
<thead>
<tr>
<th>ODF projection PHI2</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHI2  PHI1 ---&gt;</td>
</tr>
<tr>
<td>PHI</td>
</tr>
<tr>
<td>V</td>
</tr>
</tbody>
</table>
```

Example is analogically as for \(\phi_1\) section.
c) \( \phi_1, \phi_2, \Phi, \) ODF value - "ODF Export (\( \phi_1, \phi_2, \Phi, \) Odf)...":
Print to file ODF in format: \( \phi_1, \phi_2, \Phi, \) ODF (four values in each line).

For example:

<table>
<thead>
<tr>
<th>PHI1</th>
<th>PHI2</th>
<th>PHI</th>
<th>ODF</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.592089E+00</td>
</tr>
<tr>
<td>5.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.637786E+00</td>
</tr>
<tr>
<td>10.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.909632E+00</td>
</tr>
<tr>
<td>15.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.553926E+00</td>
</tr>
<tr>
<td>20.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.414515E+00</td>
</tr>
<tr>
<td>25.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.451965E+00</td>
</tr>
</tbody>
</table>

1.1.5. PF Export

Export of pole figures (CPF,RPF,NPF,APF,IPF) as ASCII files. Select PF(s) which you want to save in ASCII file and press button \textbf{OK}. Default extension is 'TPF' and default place is directory 'WORK'. An example window is shown below:

An example of file contains 220 CPF pole figure:
1.1.6. EPF/PPF/COR/POW Export
Export of original pole figures data. If source pole figure data are in non-LaboTex formats, LaboTex exports data in LaboTex formats: EPF, PPF, COR or/and POW (original data are converted to LaboTex format).

1.1.7. Print (File menu)
A 2D object(s) is printed.
Note: Print Command print only left (L) window in Compare Mode.
Shortcuts:
Toolbar:
Keys: ALT+P

1.1.8. Print Setup (File menu)
Margins are set.
Note: This set is temporary only (in current LaboTex session or to the next change).
To change it as a new default use LaboTex Options (Edit Menu)
Shortcuts:
Keys: ALT+R

1.1.9. Crystal Symmetry (File menu)
Opens dialog to change a current crystal symmetry.

Note: This set is temporary only (in current LaboTex session or to the next change).
To change it as a new default use LaboTex Options (Edit Menu)
Shortcuts:
Toolbar: OK Cancel
Keys: ALT+T

1.1.10. Recent Sample command (File menu)
Use the project/sample names listed at the bottom of the Recent Sample position menu to open the last four samples you processed or opened from menu.

1.1.11. Exit command (File menu)
Use this command to finish LaboTex session. The Close command on the application Control menu can also be used.
Shortcuts
Mouse: Double-click the application Control menu button.
Keys: ALT+F4, ALT+x
1.2. Edit menu commands

Edit menu offers the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to Clipboard (EMF)</td>
<td>Copies 2D figure(s) to the clipboard as Enhanced Metafile</td>
</tr>
<tr>
<td>Copy to Clipboard (Bitmap)</td>
<td>Copies 2D figure(s) to the clipboard as Bitmap</td>
</tr>
<tr>
<td>Image File (BMP,TIF)</td>
<td>Save LaboTex object(s) as Bitmap file</td>
</tr>
<tr>
<td>Clear Selected</td>
<td>Deletes selected PF or ODF (deletes from PF,INV or ODF containers).</td>
</tr>
<tr>
<td>Clear All</td>
<td>Deletes ODF or all PFs/INVs (empty all containers).</td>
</tr>
<tr>
<td>Color</td>
<td>Changes current colors set.</td>
</tr>
<tr>
<td>Font</td>
<td>Changes current font.</td>
</tr>
<tr>
<td>Arrangement</td>
<td>Sets objects arrangement on the screen and printer.</td>
</tr>
<tr>
<td>LaboTex Options</td>
<td>Sets initial (default) LaboTex options.</td>
</tr>
</tbody>
</table>

1.2.1. Copy to Clipboard (EMF)

Use this command to copy selected LaboTex object(s) onto the clipboard as a enhanced metafile (EMF). This command is unavailable if no data have been currently selected. Copying LaboTex object to the clipboard replaces the contents previously stored there. This option is active only when ‘Fill’ is turn off.

1.2.2. Copy to Clipboard (Bitmap)

Use this command to copy selected LaboTex object onto the clipboard as a bitmap. This command is unavailable if no data have been currently selected. Copying LaboTex object to the clipboard replaces the contents previously stored there. Before copy to clipboard LaboTex ask you about resolution. You can choose:

i) printer resolution - 2000*2000dpi
or
ii) screen resolution - current screen resolution.

Shortcuts:
- Toolbar: ![Clipboard](image)
- Keys: ALT+C

1.2.3. Image File (BMP,TIF)

Use this dialog to save LaboTex object(s) as bitmap file (only left window is saved in compare mode). You can choose:

- image format (BMP, TIF - non-compressed),
- image width (200-6000 pixels),
- image height (200-6000 pixels),
- image resolution (50-1200 DPI).
1.2.4. Clear Selected (Edit menu)

Use this command to remove the currently selected object on the screen. This command is unavailable if there is no object currently selected.

Shortcuts:
Toolbar: 
Keys: ALT+E

1.2.5. Clear All (Edit menu)

Use this command to remove all objects from containers.

Shortcuts:
Toolbar: 
Keys: ALT+L

1.2.6. The choice of the font

Opens dialog to change current font. 
Note: This set is temporary only (in current LaboTex session or to next change). To change it as a new default use LaboTex Options (Edit Menu)

Shortcuts: 
Keys: ALT+F

1.2.7. The choice of the color

It opens dialog to change current colors set. Click on the proper button 1-15 to choose set of colors. You can change colors in each colors set. In this purpose, please click on color area above buttons 1-15. It opens new dialog to change colors in colors set.
Colors 1-14 are for isolines and to fill whereas color 15 is to drawing of the axis and of circles. The colour 16 is intended as the background color when the option "Fill" is active. The position of colours 15 and 16 marked on the drawing below.

Note: This set is temporary only (in current LaboTex session or to next change). To change it as a new default use LaboTex Options (Edit Menu)

Shortcuts

Toolbar: 
Keys: ALT+L

1.2.8. LaboTex Object Arrangement

It opens dialog to change current objects arrangement on the screen. It can change arrangement for xPF, INV objects and arrangement for sections of ODF projections.

Note:

- This set is temporary only (in current of LaboTex sesion or to next change).
- To change it as a new default use LaboTex Options (Edit Menu)
1.2.9. LaboTex Options

Opens dialogs for sets initial (default) LaboTex options:

- Miscellaneous
- ODF Calculation
- Active Isolines
- Captions and Draw
- 3D View
- Arrangement
- Isoline No
- Print Setup
- Data Formats
- LaboTex conventions.

1.2.9.1. LaboTex Options – Miscellaneous

It sets miscellaneous LaboTex options as new default.
For change click on the New button:

- Isoline Colors Set Number. It opens dialog to change color set. It is available to choose from 15 colors set and to modify all color sets (see -"The choice of the colour").
- Current Font. It opens dialog to set default font in LaboTex session.
- Initial Symmetry. It opens dialog to set default crystal symmetry.
- Hexagonal Convention. It sets permanently LaboTex axis and angles convention for hexagonal system (move to LaboTex Conventions from ver. 3.0).
- Temporary directory. This directory is used by LaboTex for creation of temporary files during calculations. Optimal choice – set temporary directory on the local host.
- Data directory. This directory is default for experimental data file (EPF, PPF, SOR, ...)
- COR directory. This directory is default for correction files (COR and POW format)
1.2.9.2. LaboTex Options – ODF Calculations

It sets new default options for ODF calculations:
- Maximal Number of Iterations per Iteration Cycle. Any number in the interval 1 to 70 can be set. Default is 30.
- RP(Max) Maximal Relative Error Finishing Calculation in %. It can be set RP from 0.1% to 10%. Default is 1% (see: error definition).
- dRP(Max) Maximal Differential Error Finishing Calculation in %. dRP can be set in the interval from 0.1% to 10%. Default is 1%.(see: error definitions).

1.2.9.3. LaboTex Options – Active Isolines

For each isoline number (chosen from 1 to 14 in LaboTex Options – Isoline No) the active isolines are selected. It sets the new default.

**Notice:** number of active isolines can not be greater than the chosen number of isolines
1.2.9.4. LaboTex Options – Captions and Draw

It selects which captions and other draw elements will be present on the figures xPF (CPF, NPF, RPF, APF), INV and ODF. Axis captions contain up to 3 characters. These captions are displayed in “3D View” window too. The size of sample name captions of xPF or INV can be changed. This size is set as % of pole figure radius. The line width of picture draw (pen width) can be changed in the range 0 to 20. The 0 value specified as pen width sets line width to single pixel. Default is 0.

1.2.9.5. LaboTex Options – 3D View

Sets new defaults for miscellaneous options for 3D View window (in brackets - default):
- Distance (normal)
- Rotate angle (30 deg)
- Cycle angle (user break)
- Cycle step (2.5 deg)
- Color (isoline color – colors set identical as for 2D isolines)
- Axis view (on)
- View projection: perspective or parallel (perspective)
- Height of xPF or INV isolines (normal)
- Top black contour - black isolines in space (on)
- Bottom black contour - black isolines on the bottom surface (on)
1.2.9.6. LaboTex Options – Arrangement

Dialog is opened to change current arrangement of objects on the screen. It can change arrangement for xPF, INV objects and arrangement for sections of ODF projections.

1.2.9.7. LaboTex Options – Isoline No

Dialog is opened to change initial number of isolines. It can change independently number of isolines for xPF, INV and ODF objects.
1.2.9.8. LaboTex Options – Print Setup

It sets the margins on the picture (window).

1.2.9.9. LaboTex Options - Data Formats.

It sets the data formats. This data formats are used in Open Sample dialog. LaboTex formats: EPF, PPF, SOR are fixed. User can choose 4 additional data formats from more than 30 non-LaboTex data formats. You can find on the page: labotex.com/format.htm current list of formats which are available in LaboTex. You can also for each data format change registration convention from LaboTex default. The possibility of accommodation of a registration convention for pole figures are following:

- counter-clockwise;
- +90 deg pole figure rotate;
- +180 deg pole figure rotate.

You can use this option also when you incorrect install sample in the goniometer, receive sample from laboratory using other convention etc.
When background data of pole figure is greater than pole figure data for some values LaboTex can do:

a) negative values of pole figure after correction for background are set to zero.

b) adds to all pole figure data absolute value of the lowest values of pole figure after correction for background (LaboTex makes all data positive);

User may choose option a) or b) in "LaboTex Option" ----> "Data Formats". Default is option a).

LaboTex informs user's when it finds data for which background data are greater than pole figure data and LaboTex display percent these data:

1.2.9.10. LaboTex Options – LaboTex Conventions

1) Hexagonal Convention. It sets permanently LaboTex axis and angles convention for hexagonal system.

2) The possibility of accommodation of a plot convention for pole figures. The choice among different conventions you can find in "LaboTex Options" ----> "LaboTex Conventions". You can choose start plot pole figures from "N","E","S" or "W".

For example: if you would like plot pole figures with rolling direction "RD" in "E" you should choose in "LaboTex Conventions" start plot pole figures from "E" and next you should change description of Y axis to "RD" in "Captions and Draws" (LaboTex Options). Please also delete old description of X axis. You can also write any other description of your axis.
Pole figures: Start from North

The same pole figures when start is from East:
1.3 View menu commands

View menu offers the following commands:

- **Single Window Mode**: Shows data in the single window on the screen.
- **Compare Window Mode**: Compare mode. It shows data in two windows (left L, right R) on the screen.
- **3D View**: Opens a new window and shows data in 3 dimension coordinates.
- **Show InfoBox**: Opens (closes) an information window.
- **Magnification**: Magnifies the selected object.
- **Basic Region**: Shows only the basic region of PF or INV.
- **High Resolution(ODF)**: Shows ODF data in high resolution.
- **Number of isolines**: Sets numbers of isolines for PF,INV or and ODF figures.
- **Fill**: Fills 2D plots
- **User Defined Section**: ODF(s) or Pole Figure(s) section (cuts)
- **Grid (Pole Figure)**: Shows grid for pole figure(s) defined by user

### 1.3.1. Single Window Mode (View menu)

Objects (xPF, INV, or ODF) are shown in the single window on the screen.

**Shortcuts:**
- **Toolbar**: [icon]
- **Keys**: ALT+S

### 1.3.2. Compare Window Mode (View menu)

Objects (xPF, INV, or ODF) are shown in two windows (L - left, R - Right) on the screen. Pole figures type objects (CPF, NPF, RPF, APF), inversion pole figure type objects (INV) and orientation distribution function (ODF) type objects can not be displayed in one window simultaneously. You can display different type objects using 'Compare Mode'. In the compare mode you can work in two windows using different or the same type of objects. In this mode following options are not active:

- calculation (ODF, APF, INV);
- creation of new sample (CPF);
- quantitative analysis.

**Shortcuts:**
- **Toolbar**: [icon]
- **Keys**: ALT+C

### 1.3.3. 3-D View (Menu View)

It opens new window and shows LaboTex object in 3 dimensional space. The program includes on-screen graphic presentation of calculated ODFs, PFs and INVs in the form of contour levels (isolines) shown in 3D space. 3D objects plotted on the screen are optionally:

- increased or decreased (Distance menu),
- shifted (Shift menu)
rotated (Rotate menu)
- animated (Cycle menu).

It is possible change colors set individually for "3D View" in color menu, and other "3D View" draw options in Options Menu (axis view, black contour view, height 3D objects, kind of projection). Commands: Refresh, Copy to Clipboard, Print 3D and Exit there are in Miscellaneous Menu.

**Note:** In Compare Mode "3D View" is possible for left window only.

1.3.4. Show InfoBox (View menu)

Opens (Closes) an information window (InfoBox).

Information window contains:

1) The following isoline areas where the current isoline properties can be changed:
   - color
   - on/off switches of drawn isolines (buttons with numbers 1 to 14)
   - values of isoline levels (PF, or INV or ODF)
   - decimal digits – number of displayed decimal digits in values of isolines
   - all button – activates the drawing of all isolines
   - none button – terminates the drawing of all isolines
   - sort – sorts isolines by values
   - fill - background color (If you would like set permanent background color of filling then choose: LaboTex Options ⇒ Miscellaneous ⇒ Isoline color set ⇒ New ⇒ color number 16.
   - fill - isoline color (normal, black, white)
   - mode :
     - automatic : LaboTex calculates values of isolines
     - manual : User can define values of isolines manually
     - file : Values (colors, state) of isolines are read from file.
• save – saves current properties of isolines: values, colors, state (select the save option)

2) Global minimal and maximal values of shown objects
3) Information about selected object (click on the object to select it):
   • HKL, XYZ or projection
   • sample name
   • project name
   • describing text
   • date
   • minimal and maximal values for selected object
   • PF, INV or ODF ranges
   • crystallographic system and cell parameters

4) Captions
   • HKL or INV
   • type of PF object: CPF, RPF, NPF, APF, INV
   • sample name (caption under PF picture)
   • axis – maximal 3 characters captions:
     • X - horizontal
     • Y - vertical
     • Z - perpendicular
   • visible - turns drawing on/off for: isoline descriptions
   • minimum and maximum values
   • date

Shortcuts:
Toolbar: 
Keys: ALT+I
1.3.5. Magnification (View menu)

Magnification of Selected Object (by double mouse click).

**Shortcuts:**
- Toolbar: ![Magnification Icon]
- Keys: ALT+M

1.3.6. Basic Region (View menu)

Shows basic region of PF. Basic region means half circle of PF in case of monoclinic sample symmetry, quarter circle of PF in case of orthorhombic sample symmetry or 2D radial section of xPF.

**Example:** Pole figures for different basic regions:

![Pole Figures](image)

**Shortcuts**
- Toolbar: ![Basic Region Icon]
- Keys: ALT+B
1.3.7. High Resolution

Shows ODF objects in high resolution or low resolution. ODF can be drawn in high resolution in case the source PFs were measured in a grid less than 5 x 5 degree (2.0 x 2.0 degree from version 3.0). This option speed draw of object on the screen. Volume fraction calculation should be made for high resolution mode!

Shortcuts:
 Toolbar: 
 Keys: ALT+R

1.3.8. Number of Isolines

Sets number of isolines for each container type:
1) PF objects
2) INV objects
3) ODF objects.

Note:
• To set default value for this option see: Edit Menu → LaboTex Option → Isoline No
• To set default for active isoline(s) see: Edit Menu → LaboTex Option → Active Isolines
• To set active isoline(s) see: Infobox

Shortcuts:
 Toolbar: 
 Keys: ALT+N

1.3.9. Fill

Use this command for filling 2D plots (please sort isolines before!)
Example of action of "Fill" command:
Filling options.

You can change options of filling:
- Open infobox (click on the icon)
- Find fill segment (below box of decimal digits)

You can change:
- Background color (click mouse on the background color window)
- Isoline color (normal, black, white, continuous).

If you would like set permanent background color of filling then choose:
LaboTex Options ⇒ Miscellaneous ⇒ Isoline color set ⇒ New ⇒ color number 16.

"Continuous" 2D and 3D visualization of pole figure, inverse pole figure, ODF section and ODF (full color visualization on the base of the value of each point of the object. In 3D visualization height in each point is a function of PF, IPF or ODF value). Very good option in presentation and in publication.

**WARNING:** This option needs installation of OpenGL Driver for your graphic card! Printing plots in this option may be longer. Choose: 'Fill' next 'Open InfoBox' and in fill option change from 'Normal' to 'Continuous' in Isoline Combo Box.
Examples for option ‘Continuous’ in 2D and 3D view:

ODF Section - 3D  (1)

ODF Section - 3D  (2)
Pole Figure - 3 D (1)

Pole Figure - 3 D (2)
Pole Figures - 2D (1)

Pole Figures 2D (2)
Inverse Pole Figure - 2D

The meaning of fill options in 3D ODF visualization:

- Fill off (option are non-active, only isolines are drawing):
- Normal (isolines+transparent filling):

- Black (opaque filling):
- White (transparent filling):

- Continuous (transparent filling, transparence is function of ODF value):
The meaning of fill options in 2D visualization (IPF example):

- Fill off (fill options are non-active, only isolines are drawing):

- Normal (color filling and isolines are in the same color):
- Black (color filling and black isoline):

- White (color filling and white isoline):

- Continuous (color filling in function of PF, INV/IPF or ODF values, no isolines):
Filling of pole figures when are presented in basic region.

- Example for orthorhombic sample symmetry

- Example for monoclinic sample symmetry
WARNING: LaboTex has user defined legend. Default is "Automatic". User may change to "Manual" or to any user defined files with isoline values. For example and details see to "Determination of Volume Fraction of Texture Components Using LaboTex" manual. User can save in every time current isolines. It is very important compare objects the same type for the same set of isolines.

1.3.10. User Defined Sections (PF, ODF)

ODFs Section/Cuts (active when ODF projection is displayed):

a) ODF line sections (cuts) - user define two points (ϕ₁, Φ, ϕ₂) in Euler Space:
   - Start Point
   - End Point

LaboTex shows ODF intensity along section defined on the base these points. User can also choose initial points from orientations database (when click on the 'Start Point' or 'End Point' button database is available). Comparison up to 12 ODFs is possible:

![Graph showing ODF intensity along a defined section with Euler angles and isocontours.](image-url)
b) **skeleton lines** - user can create such diagrams as: alpha-fiber, beta-fiber, gamma fiber etc.. User can choose skeleton lines on the base of Euler angle (Phi1, Phi or Phi2) and:

i. **maximal intensity** ;

ii. **integral intensity**.

User can also change ranges in which LaboTex looking for maximal odf value or made integration (from +/-2 to +/-20 deg). User can make comparison up to 12 of skeleton lines;

**Example:**
Options: 'No fill', 'All black' (for black and white paper):

---

**Option: 'Fill':**
c) misorientation histograms. User define start point \((\phi_x, \phi_y, \Phi)\) in Euler Space from which LaboTex shows misorientation diagrams.

Misorientations diagrams are calculated on the base of ODFs in range 0 to 80 deg from start point (start orientation). LaboTex shows intensity which is the relative intensity i.e.intensity relate to intensity of random sample \((I=I(\text{sample})/I(\text{random sample}))\) for the same range of misorientation angle. User can make comparison up to 12 misorientations histograms. User can also change histogram step in range 1 to 10 degrees.

There are many options to optimize quality of diagrams:

- scale (in percent of maximal intensity value: 0.1 up 100%);

- colors (defined by user);
- types of lines (14 types with different dots+solid and width /0 to 10 pixels/);

![Choose line dialog box]

- line options (all solid, all black, black contours);

![Line Options]

- fill.

User can also save current parameters and/or samples.
User can choose ODFs for comparison using appropriate comboboxes and buttons on the tools window from right side of diagram:

The first ODF is current ODF hence user can not change its (it is grayed). Next 2 to 12 ODFs user can choose from ODF with the same crystal symmetry.
LaboTex shows also cuts for pole figures. User defines start and end points on the pole figure and Labotex shows intensity along this section.

You can also save current parameters. You can also copy and paste these diagrams to other applications or you can made images in 'BMP' or 'TIF' format (menu 'Edit').

There are following cuts available:

- 'Arc' (in range 0 to 360 degrees):
- **'Radial'** (in range 0 to 90 degrees):

- **'Radial (full)'** (in range 90 - 0 - 90 degrees):

LaboTex shows position of section line on the pole figure only when button 'View' is pressed
Up to 12 pole figures can be compared. All information about compared PFs are displayed in info window from left side of diagram (see below). All pole figures which sections are displayed have to be chosen before button ‘2D’ has been pressed. If you choose more than 12 pole figures then LaboTex shows sections only for first 12 pole figures. There are similar options to optimize quality of diagrams as in ODF cuts.
1.3.11. Grid (Pole Figure)

User can define grid for alpha angle and/or grid for beta angle of pole figure.

**Examples:**

Option ‘Cross’
Pole figure with grid for alpha and beta angles:
1.4. Calculation menu commands

Calculation menu offers the following commands, which make it possible to calculate Corrected PF (CPF), Orientation Distribution Function (ODF), Normalized PF(NPF), Recalculated PF (RPF), Inverse PF(INV):

- **Experimental PF to CPF**: Creations of CPF from EPF data.
- **Experimental Single Orientation Data to ODF**: Calculations of Orientation Distribution Function (ODF) from Experimental Single Orientations Data Set(s).
- **CPF to ODF, NPF, RPF, INV**: Calculations of Orientation Distribution Function (ODF), Normalized PFs, Recalculated PFs, Inverse PFs from Corrected PFs.
- **ODF to APF**: Calculations of Additional PF from ODF.
- **ODF to INV**: Calculations of Inversion PF from ODF.
- **ODF to ODF (ODF symmetrization)**: Symmetrization of ODF.
- **ODF to SOR**: Calculations of set of single orientations on the base of current ODF and creations of SOR file.

1.4.1. Experimental PF to CPF (Calculation menu)

Generation of Corrected Pole Figures (CPF) from experimental pole figure(s) data (files type EPF, PPF or in other formats).

For details please see to New Sample/Project command (File menu).

**Shortcuts:**

Toolbar: 
Keys: ALT+C

1.4.2 Experimental Single Orientation Data to ODF (Calculation menu)

Calculations of Orientation Distribution Function (ODF) from experimental single orientations data set(s) (files type SOR or in other formats). For details please see to New Sample/Project command (File menu).

**Shortcuts:**

Toolbar: 
Keys: ALT+S

1.4.3 CPF to ODF, RPF, NPF, INV (Creations of ODF, Calculation Menu)

Calculations Orientation Distribution Function (ODF), Normalized PF (NPF), Recalculated PF (RPF), Inverse PF (INV), from Corrected PF (CPF). To begin ODF calculation press button ‘**Run calculation**’. Some default values for CPF parameters can be changed (for current calculation) if necessary before pressing ‘Run calculation’:

1) select pole figures for ODF calculation (using buttons {HKL})
In above example will be created third job. All pole figures will be used in ODF calculation (PFs with pressed buttons: \{100\}, \{111\}, \{211\},\{113\}).

2) an experimental pole figure data can be transformed to the presupposed sample symmetry before ODF calculation. Select the desired kind of symmetrization (select proper button). You can either make symmetrization after ODF calculations (ODF symmetrization).

3) the sample used for X-Ray analysis may be mounted on the goniometer to a slight misalignment. Sample can be either cut out of the bulk sample not precisely. You can correct these effects by rotation of PF. Select proper rotation angle of PF(s) (change slider position).

4) If experimental data in the certain range angles are in your opinion incorrect you can remove it from ODF calculations. Select proper ranges of PF(s) - lower and upper ranges of pole angle (change slider position).
5) select the maximal number of iterations per iteration cycle (change slider position). It finishing ODF calculations if calculation aren't terminates by RP or dRP limits.

6) select the RP value limit (change slider position). Definition of RP value limits you can find in chapter: "Definitions of fit error in ODF calculation"

7) select the dRP value limit (change slider position). Definition of dRP value limits you can find in chapter: "Definitions of fit error in ODF calculation"

Note: It is recommended that the above parameters be altered only by experienced users!

Shortcuts:

Toolbar:

Keys: ALT+O

1.4.4. ODF to APF (Calculation menu)
Calculation of Additional Pole Figures (APF) from ODF. Choose proper indices for APF and next click button: "Start APF Calculation".
1.4.5. ODF to INV (Calculation menu)

Calculations of Inverse Pole Figures (INV) from ODF. Choose proper indices for APF and next click button: "Start INV Calculation".

![Inverse Pole Figures (INV) Calculation](image)

1.4.6. ODF to ODF. ODF Symmetrization (Calculation menu)

If you find that ODF has higher symmetry than current sample symmetry then you can create ODF with higher sample symmetry using this option (when you create ODF with pole figures you can also make calculation of ODF once more assumed higher sample symmetry of pole figures – see to point 1.4.3)
New ODF (ODF after symmetrization) is placed in next free job. Original ODF you always can find in job nr 1. Maximal number of jobs is equal 9.

1.4.7. ODF to SOR. (Calculation menu)
LaboTex creates set of single orientations on the base of current ODF. User can choose number of single orientations from 10000 to 9999999.

This option is important for user which modelling deformation (VCS users) etc. User can also generate random set of single orientation using this option. SOR file creates by LaboTex user can input as a new sample and he can make ODF calculation.

Examples:
ODF creates on the base set of 500,000 single orientations generates with 'Random' option:
Section of pole figure \{111\} calculated on the base above 'Random' ODF:

Comparison pole figure for real texture free (random) sample (red) with pole figure generates from 'random' ODF creates on the base set of 500,000 single orientations (blue):
1.5. Analysis menu commands

Analysis menu offers the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation Analysis</td>
<td>Opens an orientation analysis.</td>
</tr>
<tr>
<td>Show PF(s) or/and ODF(s) &amp; Value(s)</td>
<td>Displays average PFs value or/and ODF value from cursor(s) position(s).</td>
</tr>
<tr>
<td>Choose (HKL) [UVW]</td>
<td>Opens the window to choose orientation in (HKL)[UVW] indices.</td>
</tr>
<tr>
<td>Orientations Type Database</td>
<td>Opens the window to add or edit orientation in database.</td>
</tr>
<tr>
<td>Sort Orientations from Database by PF or ODF Values</td>
<td>Opens the window with sorted out orientations from database by PF or ODF values.</td>
</tr>
<tr>
<td>Show Next Orientation from Database</td>
<td>Changes current orientation to the next orientation in database.</td>
</tr>
<tr>
<td>Show Previous Orientation from Database</td>
<td>Changes current orientation to the previous orientation in database.</td>
</tr>
<tr>
<td>Automatic Show of Orientations from Database</td>
<td>Automatic display of orientations from database (sequentially).</td>
</tr>
<tr>
<td>Near(HKL)[UVW] orientations</td>
<td>Displays list which contains near (HKL)[UVW] orientations to orientation for current cursor position.</td>
</tr>
<tr>
<td>Quantitative Analysis – Integration Method</td>
<td>Opens the dialog for IM</td>
</tr>
<tr>
<td>Quantitative Analysis – Model Functions Method</td>
<td>Opens the dialog for MFM</td>
</tr>
</tbody>
</table>

1.5.1. Orientation Analysis (Analysis menu)

Opens appropriate orientation analysis – using the cursor(s).

Note: In current version of LaboTex orientation analysis is non implemented for Inverse Pole Figures..

Shortcuts:

Toolbar:  
Keys: ALT+O

1.5.2. Show PF(s) or/and ODF(s) Value(s) (Analysis menu)

Activates the display of sums PF value(s) or/and ODF value in cursor(s) position(s) (for more than one of PF objects - average of sums).

Example (Compare Mode - PF in right window, ODF in left window):

(R) = 13.1 – average of sums pole figures values in cursor positions (for all xPF object in right window).
(L) = 0.21 – ODF value in cursor position (for ODF in left window).

Shortcuts:

Toolbar:  
Keys:  

52
1.5.3. Choose (HKL)[UVW] (Analysis menu)

Opens the window allowing to select orientation in (HKL)[UVW] indices and you can see for active window: cell parameters, orientation type (Euler angles and Miller indices), basic region, orientation(s) in basic region (Euler angles and Miller indices). LaboTex shows orthogonal vectors \( \{ \text{HKL} \} < \text{UVW} > \) for indices lower than 15.

Shortcuts:

Toolbar: Click on the (HKL) or [UVW] edit box
1.5.4. Orientations Type Database (Analysis menu)

Opens the window allowing to add or edit orientations in database.

1.5.5. Sort of Orientations from Database by PF or ODF Values (Analysis menu)

Opens the window with assorted orientations from database by PF (when PF object are displayed on the window) or ODF values (when ODF projection or section is displayed on the window).

**Shortcuts:**

**Status Bar:** Sort

**Keys:** ALT+S

Examples for "SORT" for pole figures and "SORT" for ODF.
Sort for pole figures:

Sort for ODF:
1.5.6. Show of Next Orientation from Database (Analysis menu)

Changes cursor position of current orientation to the:
- next orientation type from database (for pole figures objects);
- next symmetrically equivalent orientation calculated by LaboTex or next orientation type from database if all symmetrically equivalent orientations were showed (for ODF objects).

**Shortcuts:**

- Status Bar: [Next]
- Keys: ALT+N

1.5.7. Show of Previous Orientation from Database (Analysis menu)

Changes cursor position of current orientation to the previous orientation from database.

**Shortcuts:**

- Status Bar: [Prev]
- Keys: ALT+P

1.5.8. Automatic Show of Orientations from Database (Analysis menu)

Automatic display of cursor position of orientations from database (one after one).

**Shortcuts:**

- Status Bar: [Auto]
- Keys: ALT+A

1.5.9. Near (HKL)[UVW] orientations (Analysis menu or right mouse button)

Displays list which contains near (HKL)[UVW] orientations to orientation for current cursor position. This option can be chosen by mouse too. For activate select "Orientation analysis" next click right mouse button in selected point on the pole figure or ODF projection. "Near orientations" can be sorted by PF or ODF values, Miller indices, distance in Euler space and misorientations.

![Near (HKL)[UVW] Orientations Table]

<table>
<thead>
<tr>
<th>UDF</th>
<th>[HKL][UVW]</th>
<th>θ</th>
<th>φ</th>
<th>Misorientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.617</td>
<td>[1 1 0] [2 -2 1]</td>
<td>45.0</td>
<td>0.0</td>
<td>9.85</td>
</tr>
<tr>
<td>1.617</td>
<td>[1 1 0] [2 2 1]</td>
<td>45.0</td>
<td>0.0</td>
<td>9.85</td>
</tr>
<tr>
<td>1.569</td>
<td>[5 1 0] [1 -5 1]</td>
<td>60.0</td>
<td>0.0</td>
<td>6.88</td>
</tr>
<tr>
<td>1.537</td>
<td>[1 0 0] [0 0 2]</td>
<td>45.0</td>
<td>0.0</td>
<td>10.86</td>
</tr>
<tr>
<td>1.537</td>
<td>[2 1 0] [1 -2 0]</td>
<td>45.0</td>
<td>0.0</td>
<td>10.86</td>
</tr>
<tr>
<td>1.537</td>
<td>[2 1 0] [1 -2 0]</td>
<td>45.0</td>
<td>0.0</td>
<td>10.86</td>
</tr>
<tr>
<td>1.516</td>
<td>[5 1 0] [1 5 0]</td>
<td>45.0</td>
<td>0.0</td>
<td>5.31</td>
</tr>
<tr>
<td>1.463</td>
<td>[1 0 0] [0 -3 1]</td>
<td>45.0</td>
<td>0.0</td>
<td>5.31</td>
</tr>
<tr>
<td>1.463</td>
<td>[3 1 0] [1 -3 0]</td>
<td>45.0</td>
<td>0.0</td>
<td>18.53</td>
</tr>
<tr>
<td>1.463</td>
<td>[1 0 0] [0 -3 1]</td>
<td>45.0</td>
<td>0.0</td>
<td>4.34</td>
</tr>
</tbody>
</table>

Max. Value of Miller Indice = 15
1.5.10. Quantitative Analysis – Integration Method (Analysis menu)

For details and examples see manual: "Determination of Volume Fraction of Texture Component using LaboTex – Integral Method" (download from [http://www.labosoft.com.pl](http://www.labosoft.com.pl) or find this manual in LaboSoft folder)

Opens the window for Quantitative Analysis. It makes it possible to calculate volume fractions of chosen set of texture components. In order to complete the quantitative texture analysis, the following steps are recommended:

1) display one of ODF projections,
2) identify the texture components (showing orientations from database and/or identifying orientations components by manual movement of the cursor),
3) select Quantitative Analysis from Analysis menu or press % icon
4) select texture components (orientations) for integration of volume fractions
5) select the integration width (change slider position) of each Euler angle for selected components
6) press calculation of volume fraction of texture components button
You can also set up value of background (default value of background is minimal value of ODF).

**Note:** Quantitative Analysis is possible in Single Window Mode only.

**Shortcuts:**
- Toolbar: 
- Keys: ALT+Q

### 1.5.11. Quantitative Analysis – Model Functions Method (Analysis menu)


Model function method is very helpful for analysis of texture with overlapping components.

Using this method you can determine volume fraction of texture components assumed that these components have Gauss or/and Lorentz distributions.

After calculation you can simple compare experimental ODF with calculated:

**Example**
Compare experimental (from left) and calculated (from right) ODFs

**Note:** Quantitative Analysis is possible in Single Window Mode only.
### 1.6. ‘Modelling’ menu commands

**• Model ODF**
Modelling of ODF (Creates of ODF on the base model functions)

**• ODF Transformations**
LaboTex calculates new ODF which is result transformation of initial ODF

**• ODFs logical operations**
Creates new ODF on the base logical operations between two ODFs

#### 1.6.1. Model ODF (Modelling menu)

You can very easy create of a model ODF.
You can choose for output ODF:

- Crystal Symmetry;
- Sample Symmetry:
- Grid cells

and next you can choose one or more components (up to 10 components). For each texture component you can choose:

- volume fraction;
- FWHM for each Euler angle (phi1, phi2 and phi);
- distribution (Gauss or Lorentz).
Next (from a model ODF) you can create any model pole figures or/and any model inverse pole figures using appropriate dialog for create of APF (additional pole figures) or for IPF (inverse pole figures).

1.6.2. ODF Transformation (Modelling Menu)

LaboTex calculates new ODF which is result transformation of initial ODF. New ODF is created in new job for sample of initial ODF. There are two kinds transformations:

- **frame rotations** - user can rotate sample frame. This option is very important if user would like to see ODF for other (different) sample position (for example if you want see ODF for the perpendicular surface with relation to surface which was measured you should transform initial ODF about Phi=90deg). User can create change sample symmetry for new ODF.
Example:

Initial ODF (3D Image) – Cubic:

Initial ODF (ODF with Cubic orientation) - after transformation of frame (45 degrees, Phi axis) gives ODF with Goss Orientation:

- **builder of model rotations.** (crystalites/planes rotations). In first step you build rotation model and save it. In rotation model you can choose up to 10 orientations for which you set:
  - ranges of Euler angle around center of orientation (and for symmetrically equivalent positions);
  - vector "hkl" around which will be rotate crystalites/planes (only these which are included in ranges chosen by user);
  - rotation angle;
  - recent of rotated crystalites/planes (from 0 to 100%).
In second step you choose rotation model and make ODF transformation:
1.6.3. ODFs logical operations (Modelling menu)

**ODFs - logical operations.** For activate this option user should switch LaboTex to ‘Compare Mode’ and next choose two ODFs for comparison: one in left window and second in right window (LaboTex Compare Mode). On the base these two ODFs (A - from left window and B from right window) LaboTex creates new ODF which is:

- **intersection** of ODF A and ODF B,
- **difference** of ODF A and ODF B (or B-A),
- **union** of ODF A and ODF B,
- **sum** of ODF A and ODF B,
- **ODF difference**: A or B - intersection A and B,
- **inverted ODF** (only for A).

New ODF is created in new Job for sample of ODF A. You can copy and paste these diagrams to other applications or you can made images in 'BMP' ot 'TIF' format (menu 'Edit').
1.7. Help menu commands

Help menu offers the following commands, which provide assistance for LaboTex:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Contents</td>
<td>Shows appropriate index of help topics.</td>
</tr>
<tr>
<td>Help Search</td>
<td>Searches the online help.</td>
</tr>
<tr>
<td>About</td>
<td>Displays the user and company, serial number and version number of LaboTex.</td>
</tr>
</tbody>
</table>
2. Object Toolbar

The object toolbar is displayed across the top of the application window, below the Main Toolbar. The toolbar provides quick mouse access to LaboTex object,

Object toolbar contains:
1. Object type buttons :
   - CPF
   - NPF
   - RPF
   - APF
   - INV
   - ODF

2. Job buttons
3. Object buttons
   - hkl for CPF, NPF, RPF APF object type, for example :
   - XYZ for INV object type, for example :
   - Φ1, Φ2, Φ for ODF object type :

To select the object, click object type button first, then job button and next click proper object button. If object type button is grey (as APF in below example), sample contains no APF object!